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2. Intr oduction

2.1. About This Manual

This manual is the reference to the SyCOS System Status Display for the
SyCOS Operator Consoles.

The System Status Display is an application with a graphical user interface. It
provides the operator with information about the status of the system hardware
and software components in the network. Additional configuration information
can also be displayed.

2.2. Who This Manual Is For

This manual has been written for the plant commissioner and possibly for the
plant operator.

2.3. To What Does This Manual Apply

This manual is applicable to SyCOS version 9.2.0.

2.4. How This Manual Is Organized

The general concept of the System Status Display is introduced in chapter 3.
“Concepts” on page6.

The functionality will be presented in chapter 4. “Functionality” on page7. It
includes browsing through the nodes of the SyCOS network and viewing
detailed informations about these nodes and their components.

The behaviour in non normal situations is described in chapter 5. “Exceptions”
on page16.

2.5. Related Documents

Refer to the bibliography for a list of related documents.

2.6. Conventions Used in This Manual

TheCourier font is used to highlight user inputs, file and directory names, the
name of the system utilities that are included from the operating system com-
mand line.



System Status Display Introduction

1.1 5

2.7. Request for Comments

If you have any problems with this text contained in this manual or you wish to
make suggestions for improvements then contact the SyCOS Product Support
Group, namely:

Mr. Rolf Breitenstein
Syte GmbH
Seewenweg 5
CH-4153 Reinach, Switzerland

Please provide the full name of the document and its version number.

2.8. Acknowledgments

This manual was written by Philippe Cadé.
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3. Concepts

Purpose The System Status Display (SSD) provides the operators and the plant commis-
sioner with information about the status of the system hardware and software
components in the network.

License The System Status Display is license dependent. For more details, please refer to
the SyCOS Operator Console [SyCOSOC] manual.

Presentation The System Status Display has the presentation of a browser: objects are organ-
ized in a hierarchical form on the left hand side and detailed information on
these objects are displayed on the right hand side.

Here is an example of a System Status Display window:

Figure 1: System Status Display window

Hierarchical view On the left hand side of the application window, a hierarchical view of the
SyCOS network is shown in a tree form. The first level in this tree include all the
PIC (Process Information Center), Fileservers and MFC (Multi Function Con-
troller) defined in the SyCOS configuration file (cf. SyCOS System Configura-
tion Definition manual). Each of these nodes also have subnodes, which show
elements contained in or depending on these nodes. See “Hierarchical view” on
page8.

All the nodes can be selected (only one object selected at a time) to display sta-
tus and configuration information on the selected node in the right part of the
application window.

The status of the nodes can be easily recognized with a color coded status icon.
See “Color codes” on page12.

Detailed view On the right hand side of the application window, detailed information about the
selected node is shown. The information shown depends on the type of the object
which is selected in the hierarchical view.
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4. Functionality

4.1. Invocation

The System Status Display is automatically invoked when you log in using an
operator account. It is then available as an icon.

When logged in as an operator, you may (re-)start the SSD by pressing the right
mouse button on the root menu (background of the screen) and dragging the
mouse to the "Restart System Status" line and releasing the mouse button there.

Proceed as follows, when you log in using a regular unix account: Make sure
your$DISPLAY variable is set. Make sure thecolormgr (color manager) is
running for this particular display. Call thecolormgr (again) or use the

ps -ef

command to find out. Preferably invoke SSD using the command

sysstat &

where the& stands for running as a background task. This will start the SSD as a
normal size window. If you want the SSD to be started as an icon, enter

sysstat -icon &

Figure 2: System Status Display icon

4.2. Refresh

The System Status Display shows both static and dynamic data. The dynamic
data has a refresh rate of 2 seconds.

Only the visible part of the data is regularly updated.

If no value is available at a given time (i.e. no update has occured yet), either
nothing is displayed (for lists) or the “...” string is shown (for tabular presenta-
tions) or a white or black icon is presented.
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4.3. Browsing

To be able to see the information which is looked for, the user will first browse to
the object concerned in the hierarchical view and then select the appropriate tab
in the detailed view.

4.3.1. Hierar chical view

The hierarchical view is composed of a tree which has the following structure:

• the top level is always the SyCOS network, its name is displayed

• one level below the network, the nodes are displayed. These include: PICs,
fileservers and MFCs, their name is displayed.

The structure under a PIC, fileserver or MFC is the following:

MFCs We distinguish 2 types of MFCs: the bus based one (e.g. Vision Compact) and
the rack based ones. For both MFC types, all the racks connected to it are shown
under their respective bus. Under the rack, the interface cards which are con-
nected to that rack are shown. For the bus based MFCs, all the busses defined for
that MFC and the modules attached to these busses are shown.

Note: if the MFC is offline, the MFC will not have any children in the tree view.

Color codes All the objects in the tree have an icon showing the current status of that object.
Color is used to identify the status (See “Color codes” on page12).

Browsing in the tree Items having children can be opened or closed to show or hide these children. To
open such an item, either click with the left mouse button on the little arrow
located to the left of the status icon (it points to the right) or double click with the
left mouse button on the name of the item. Use the same procedure for closing
the object (the little arrow will then be pointing to the bottom).

Selecting items Items in the tree can be selected by clicking once with the left mouse button on
the item’s name or the item’s status icon. The detailed view of the selected item
will be shown on the right side of the application window.
Only one item can be selected at a time.

PIC or fileserver

Alarm destinations
Consoles
Modems
Pagers
Printers
Storage
Trend

MFC

bus
module

interface card

rack
bus
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4.3.2. Detailed view

The detailed view shows information about the item which is selected in the
hierarchical view. The information is divided in sections and one section is
shown at a time.

Browsing through the tabs The sections are represented on the screen by tabs:

Figure 3: Tabs in the detailed view

Only one tab is visible at a time. To change the visible tab, click with the left
mouse button on the desired tab name.

curr ent tab

tabs

contents of
curr ent tab
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4.4. Contents of the detailed view

Depending on the type of the object selected in the hierarchical view, the right
side of the application window shows detailed information about that item. Here
is an overview of the available information for each object type. Information
which is regularly updated is marked with a *.

4.4.1. PIC / Fileserver

The detailed information for a PIC / Fileserver consist of 2 tabs:

• PIC
The name, manufacturer, location, IP address, CPU type, memory, status (on-
line/off-line) (*) and up time (*) of the SyCOS system is shown.

• Services
The status of the SyCOS daemons are listed. (*)
These daemons are internal services which must be running for the normal
operation of the SyCOS system. The services which are running are prefixed
with a “+” sign, the services which are not available at the moment are
marked with a “-” sign.

4.4.2. Sub items of a PIC / Fileserver

Detailed information about following objects are shown (as defined in the
SyCOS configuration file):

• Alarm destinations
Name, number, type, if it is a system error device and implementation.

• Consoles
Name, manufacturer, location and IP address

• Modems
Name, manufacturer, location, dial in/out devices and parameters

• Pagers
Name, manufacturer, location, device and configuration file location

• Printers
Name, manufacturer, location, IP address, device and device parameters

• Storage
Name, manufacturer, location, capacity, device and device parameters

• Trend
Name, type, quota information and path

4.4.3. MFC

The detailed information for a MFC consist of 6 tabs:

• MFC
Name, manufacturer, location, IP address, CPU type, memory, boot host, sta-
tus (*), watchdog status (running/stopped) (*) and uptime (*)

• Services
The status of the daemons running on the MFC. (*)
As for the daemons on the PIC, these are internal services needed for the
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SyCOS system to run normaly: services which are running are prefixed with
a “+” sign whereas services which are not running are prefixed with a “-”.
Note: there is one exception: when the Wddev is marked with a “+”, it means
that the watchdog is pulsing whereas when it is marked with a “-”, it means
that the watchdog is not pulsing.

• NFS mount
Hostname, the file system to mount and the mount point

• NFS Auth
Hostname, user and group ids

• Interface
Name, manufacturer, location and type

• Watchdog
Name, manufacturer, location, puls width, period and cycle and status of link
checking.

4.4.4. Bus

The detailed information for a BUS consist of 1 tab:

• BUS
Type and bus number.

Note: as busses have no name, the name shown for a bus is always “busn” where
n is the bus number.

4.4.5. Module

The detailed information for a module consist of 2 tabs:

• Module
Name (*), alias, manufacturer, type (analog/digital), I/O mode (input/output),
I/O type, address (*), internal status (*), external status (*) and device data
(*)

• Channels
number and type, value (*), internal status (*), external status (*), device data
(*), range (*) and if used (*)

4.4.6. Rack

The detailed information for a rack consist of 1 tab:

• Rack
rack name, manufacturer, type and number of slots

4.4.7. Interface card

The detailed information for an interface card consist of 2 tabs:

• Interface card
Alias, manufacturer, type (analog/digital), I/O mode (input/output), I/O type,
position in the rack and status (*)

• Channels
number and type, value (*), internal status (*), external status (*), device data
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(*), range (*) and if used (*)

4.5. Color codes

The icon of the SSD and the nodes represented in the hierarchical view both use
color to display the corresponding status. Here is a list of all possible colors and
their meaning:

4.6. Object status

For each item containing dynamic data, a status information is shown. This sta-
tus is computed based on properties of the object. Here is a list of all objects
showing status and a brief explanation on how the status for the object is deter-
mined:

Table 1: color codes and their meaning

Color Status

green good

orange partially good
This status is used to show that a subnode has a bad or criti-
cal status

red bad

blinking red critical

black or white neutral
the object does not have a status (for example in case of
static data) or the status cannot be or has not already been
determined.
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Object Rule for status

Network A network is marked Good (i.e. green) if all the nodes belonging to that network are
marked Good. A network is marked Bad (red) if all the nodes of that network are
marked Bad. Otherwise, the network is marked PartiallyGood (orange).

PIC/Fileserver A PIC/Fileserver is marked Good when it is online and Bad when it is offline.

MFC A MFC is marked Critial (blinking red) when it is offline. It is marked Bad when the
watchdog is not running. It is marked Good if it is online, the watchdog is running and
all the bus and racks belonging to that MFC are marked Good. It is PartiallyGood oth-
erwise.

Bus A bus is marked Good if all the modules or racks under that bus are also marked Good,
it is marked Bad if all the modules or racks are marked Bad. Otherwise, it is marked
PartiallyGood.

Rack A rack is marked Good if all the interface cards under that rack are also marked Good,
it is marked Bad if all the interface cards are marked Bad. Otherwise, it is marked Par-
tiallyGood.

Module A module is marked Good if all the used channels are marked Good, otherwise it is
marked Bad.

Interface Card An interface card is marked Good if all the used channels are marked Good and the sta-
tus of the interface card itself is OK, otherwise it is marked Bad.

Table 2: Rules for determining status information
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4.7. Menu bar

The menu bar is located at the top of the application window and has following
entries:

4.7.1. Window menu

The Window menu has following entries:

• Print setup...
This menu item will open a standard print setup dialog box where the desti-
nation and print format can be defined. Here is a example of a print setup
window:

Figure 4: Print setup window

• Print
This menu item will start the printing of a screen dump of the System Status
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Display window, according to the settings defined in the print setup window
See “Print setup window” on page14.

• Quit
This menu item terminates the System Status Display.

4.7.2. View menu

The View menu is used to control the level shown in the Hierarchical view. Tree
items which have children are opened or closed depending on the menu entry:

• Show nodes
Only the Network level and the nodes level (including PICs, fileservers and
MFCs) are shown.

• Collapse all
All the tree items having children are closed. Only the network item will be
visible.

• Expand faulty
All items which are marked Critical, Bad or PartiallyGood are opened. All
the others are closed. Use this menu entry to quickly locate all the items
which do not have a normal state.

• Expand all
This will open all the items and show the whole contents of the hierarchy.

4.7.3. Help menu

The Help menu is the access point to the on-line help system and to version
information about the System Status Display. Menu entries are:

• Contents
This feature is not implemented yet.

• About
This will open a dialog window containing copyright and version informa-
tion. Please provide the version numbers shown when giving feedback.

Figure 5: About dialog box
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5. Exceptions

No License The message "Could not get a license for the System Status Display!" in the
authorization window indicates that too many System Status Displays are run-
ning. You must then find what console is running too many SSDs and close the
one(s) which are not really required.

Each SSD invoked requires one license to run. That is an internal SyCOS
license. If too many SSDs are started the system runs out of licenses. The
number of available licenses is plenty under normal circumstances.

The number of total licenses available is coded in the system. Four (4) licenses
for SSDs are available per PIC. The number of currently available licenses for
the SSD on a system can be found by entering the command:

license -t | grep stat

in a shell window.

SyCOS System not
running

The System Status Display can only be started when the SyCOS system is run-
ning. To check if all the SyCOS daemons are running, enter following command
in a shell window:

sycosps -q
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